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Session 2: Exploring GIS 
 
Map Production - Exploring various GIS functions 
 
Objectives: 
1. To create a map layer – Air Pollution Index (API) and its attribute table 
2. To symbolize your data   
3. To design a map layout 
 

Task 1: Creating map layer and attribute table 

1. Start ArcCatalog 
Ø In Start menu, select ArcCatalog under ArcGIS folder. 
 

 
 

2. Create a new feature layer 
Ø Select the working directory C:\yuikee\SHAPEFILE\ 

 

 
 

Ø In File menu, select New and then click Shapefile to create new Shapefile. 
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Ø Type “API” as the name of this new Shapefile in Create New Shapefile 
menu. 

 

 
 

Ø Select “Point” in the field Feature Type . 
Ø Select OK to finish. 
(You may check that a new Shapefile was created under the working directory.) 
 

3. Build an attribute table 
Ø Right click the new Shapefile “API”. 
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Ø Select Properties to open Shapefile Properties menu. 
 

 
 

Ø Select Fields  tab to open field properties menu. 
Ø In the new row, click the empty space under Field Name  column. 
Ø Type “Name” and then select Text under Data Type  column. 
 

 
 

Ø Repeat the previous step and then add the new field “API” with data type 
“Short Integer” and “Address” with data type “Text”. 

Ø Press OK to finish the attribute table creation. 
 

4. Start feature editing – adding, moving and deleting feature 

Ø In ArcCatalog toolbar, click ArcMap button  to start ArcMap. 
Ø Open the existing ArcMap Document Lesson_1.mxd 
Ø Click the Add button in ArcMap and then select API under the working 

directory C:\yuikee\SHAPEFILE\ 
Ø Click Start Editing under the Editing menu in Editor toolbar. 

(You may click the Editor button  in Standard toolbar to add Editor 
toolbar.) 
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Ø Highlight the Source where the API layer is stored. 
 

 

Ø Click the Create New Feature  button  to add API stations on the 
map.  
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5. Edit feature attributes 

Ø Right click the API layer in TOC. 
Ø Select Open Attribute Table. 
 

 
 

(To identify the corresponding feature from the map, click the record and then 
highlight the record. Corresponding feature will be highlighted) 
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Ø Type the name of API station to the field “Name” and corresponding API 
value and address in the field API and Address respectively. 

 
Attributes of API 

Name Id API Address 
Shum Shui Po 1 39 37A Yen Chow Street 
Kwun Tong 2 37 6 Tung Yan Street 

Eastern 3 30 Sai Wan Ho Fire Station 
Causeway Bay 4 56 1 Yee Wo Street 

Central 5 47 Charter Road 
Central / Western 6 31 1 High Street 

Mong Kok 7 48 Nathan Road 
 

 
 

Ø Repeat the previous step to complete all records 
Ø Close the attribute table. 
 

6. Save and Exit feature editing 
Ø Click Stop Editing under the Editing menu in Editor toolbar.  
Ø Press Yes button to save the editing. 
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Task 2: Setting the style and symbol 

1. Select single symbol 
Ø Double click the symbol below the layer API in TOC to open Symbol 

Selector menu 
 

 
 

Ø Select “Circle 2” symbol and then change the color to red in Options. 
Ø Press OK to finish. 
 

2. Select different symbol to represent different feature type 
Ø Right click the layer in TOC 
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Ø Select Properties to open Layer Properties menu 
Ø Select Symbology tab 

 

 
 

Ø Select Categories in Show menu and then highlight Unique Value 
 

 
 

Ø In Value  Field, select ID. 
Ø Press Add All Values to set different symbol for different ID. 
Ø Press OK to finish. 
 

3. Select graduated symbol to represent different value of attribute 
Ø Right click the API layer in TOC. 
Ø Select Properties to open Layer Properties menu. 
Ø Select Symbology tab. 
Ø Select Quantities in Show menu and then highlight Graduated Symbol. 
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Ø In Value  Field, select API 

 
(Remark: You may set the classification method to equal interval in 
Classification dialog box by clicking the button Classify.) 
 

Ø Press OK to finish 
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Task 3: Setting the map layout and printing 

1. Set map window to layout view 
2. Add map element 
 

 
 
Ø In Insert menu, click the Title to add map title 
Ø Click the Legend to open Legend Wizard 
 

 
 

Ø Remove all the items in Legend Items  except API and then click Next to 
finish. 

Ø Click the North Arrow to add north symbol.  
Ø Click the Scale Bar to add scale bar 
Ø Click the Scale Text to add scale text 
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3. Set map grid 
Ø In map layout view, right click the map layout and then select Properties 
Ø Select Grid tab in Data Frame Properties 
Ø Press New Grid to create new grid 
Ø Select Reference Grid and then press Next to finish 
 

 
 

4. Export the map  
Ø In File menu, click Export Map 
Ø Enter the filename and set the file to JPEG format 
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Demonstrations and practice: Applying GIS in teaching S1-S3 curriculum 
Brainstorming exercise 
The list below is the main themes you may have to teach at Junior Secondary level. 
For each, try to think about a teaching or learning activity which may make use of 
GIS: 

*For the detailed syllabus, go to Education and Manpower Bureau 
(www.emb.gov.hk)→English→Kindergarten, Primary and Secondary 
Education→Curriculum Development→Personal, Social and Humanities 
Education→Curriculum & Syllabuses→Geography→Geography (Secondary 
1-3) 

Theme Teaching/Learning Activity 
Secondary 1 

Scramble for land!  
– Urban land use 

 
 

Fixing our cities’ problems  
– Urban problems 

 
 

Where are our factories moving to?  
– Industrial location 

 

Moving out or into cities  
– Urbanization and suburbanization 

 

Where to spend our holidays?  
– Recreation and travel 

 

Secondary 2 
Weather and climate – do they 
matter? 

 
 

Collapsing slopes!  
 

Too much water!  
– Water cycle and flooding 

 
 

Taming the spreading deserts  
– Deserts and desertification 

 

The unstable Earth  
– Earthquakes and volcanoes 

 

Farming the wrong way?  
– Agriculture and technology 

 

Too many and too few  
– Population problems 

 

Secondary 3 
Save our rainforests!  
– Natural vegetation 

 
 

Oceans in trouble  
– Marine resources 

 
 

How clean is our atmosphere?  
– Air pollution and acid rain 

 

Struggle for power resources  
 

Industrial miracle  
– Industrial development 

 
 

The rich and the poor 
– Development and interdependence 
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Creating your own step-by-step manual 
 
Exercise 1 
 
The map below was worked out by a S2 student. It shows the close relationship 
between some major earthquakes, including the Kobe earthquake, and the plate 
boundaries around Japan. 
 

 
 
You may ask your students to produce a similar map, showing Japan, other 
regions or the world. Work out a detailed step-by-step manual for yourself. You 
will find it helpful for your students: 
 
1. Switch on your computer. 
 
2. ___________________________________________________________________ 
 
3. ___________________________________________________________________ 
 
4. ___________________________________________________________________ 
 
5. ___________________________________________________________________ 
 
6. ___________________________________________________________________ 
 
7. ___________________________________________________________________ 
 
8. ___________________________________________________________________ 
 
9. ___________________________________________________________________ 
 
10. __________________________________________________________________ 
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Demonstrations and practice: Applying GIS in teaching CE curriculum 
 
Brainstorming exercise 
The list below is the main themes and issues you have to teach at the new CE level. 
For each, try to think about a teaching or learning activity which may make use of 
GIS: 

*For the detailed syllabus, go to Education and Manpower Bureau 
(www.emb.gov.hk)→English→Kindergarten, Primary and Secondary 
Education→Curriculum Development→Personal, Social and Humanities 
Education→Curriculum & Syllabuses→Geography→S4-5 Geography 
Curriculum Guide 

 
Theme/Issue  

 
Teaching/Learning Activity 

 
Climate 
- Climatic Types 

 
 
 

Climatic Anomalies 
- Global Warming 

 
 
 

Landforms and Endogenetic 
Processes 
- Plate Tectonics 

 
 
 

Natural Hazards 
- Earthquakes, Volcanoes and 
Tsunami 

 
 
 

Landforms and Exogenetic Processes 
- Rivers 

 
 
 

The Trouble of Water 
Floods and Droughts 

 
 
 

Agriculture 
-Farming systems 

 
 
 

Food and Hunger 
- Famines 

 
 
 

Industry 
- Industrial Location 

 
 
 

The Choice of Power 
- Energy problem 

 
 
 

City 
-Urban development 

 
 
 

Sustainable City 
- Sustainable Development 
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Creating your own step-by-step manual 
 
Exercise 2 
 
At CE level, you may let your students try a more complicated work. Now try to 
prepare a map showing the close relationship between the location of active 
volcanoes and the plate boundaries. Work out a detailed step-by-step manual for 
your students: 
 
1. Switch on your computer. 
 
2. ___________________________________________________________________ 
 
3. ___________________________________________________________________ 
 
4. ___________________________________________________________________ 
 
5. ___________________________________________________________________ 
 
6. ___________________________________________________________________ 
 
7. ___________________________________________________________________ 
 
8. ___________________________________________________________________ 
 
9. ___________________________________________________________________ 
 
10. __________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
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Demonstrations and practice: Applying GIS in teaching AL curriculum 
 
Brainstorming exercise 
The list below is the main themes you have to teach at Advanced Level. For each, try 
to think about a teaching or learning activity which may make use of GIS: 

*For the detailed syllabus, go to Education and Manpower Bureau 
(www.emb.gov.hk)→English→Kindergarten, Primary and Secondary 
Education→Curriculum Development→Personal, Social and Humanities 
Education→Curriculum & Syllabuses→Geography→Geography (Advanced 
Level) 
 

Theme Teaching/Learning Activity 
Natural Landscapes 

Climatic System 
Energy budget & flow 
- insolation and temperature 

 

Atmospheric moisture 
- condensation and precipitation 

 

Atmospheric circulation 
- pressure and wind 

 

Climatic variation 
- climatic types 

 

Landform System 
Plate tectonics 
-plate movement and tectonic landforms 

 

Drainage basin 
- water cycle and basin subsystems 

 

Biotic System 
Ecosystem 
- energy flow and nutrient cycles 

 

Soils 
-soil forming processes 

 

Vegetation 
- plant ecology and natural vegetation 

 

Biomes 
- vegetation response to environment 

 

People-environment Relationships 
Tropical rain forest 
- deforestation and afforestation 

 

Tropical desert 
- human adaptations and desertification 

 

Agricultural Landscapes 
Farming systems 

- agroecosystems and farming types 
 

Agricultural location 
- von Thünen and Sinclair models 

 

Impact of urbanization and industrialization 
- farming changes 

 

Farming hazards 
- flooding and droughts 
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Urban and Industrial Landscapes 
Urban functions and hierarchy 

- functions of cities and Christaller model 
 

Urban structure 
- urban land use models 

 

Manufacturing location 
- Weber model 

 

Urban problems 
- housing and transport problems 

 

Environmental impact 
- pollution and environmental changes 

 

 
Creating your own step-by-step manual 
 
Exercise 3 
 
Your Advanced Level students should be capable of manipulating data with the 
GIS. Now try to prepare a map showing the close relationship between the 
location of most recent major earthquakes and the plate boundaries. Work out a 
detailed step-by-step manual for your students: 
 
1. Switch on your computer. 
 
2. ___________________________________________________________________ 
 
3. ___________________________________________________________________ 
 
4. ___________________________________________________________________ 
 
5. ___________________________________________________________________ 
 
6. ___________________________________________________________________ 
 
7. ___________________________________________________________________ 
 
8. ___________________________________________________________________ 
 
9. ___________________________________________________________________ 
 
10. __________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 
_____________________________________________________________________ 
 


